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Introduction 

General 

Luxriot FR (further referred to as LFR) is a biometric face recognition application designed to 
work with Luxriot VMS. Leading-edge technology assures optimal system performance and 
reliability with real time face detection, concurrent multiple face recognition and instant 
face matching in 1-to-1 and 1-to-many modes. 

Key features: 

- Efficient face recognition engine with low error rate 
- Face liveness detection preventing cheating with a photo in from of camera 
- Variety of supported IP cameras, encoders and analog CCTV devices 
- Simultaneous multiple video stream processing  
- No imposed limitation on amount of cameras 
- User friendly interface for easy setup, monit+6oring and data retrieval 
- Simple installation with ready-to-go database 
- Possibility to use own database 

Luxriot Face Recognition is perfectly suited for HR control systems as well as for security and 
enforcement applications. 

This document will guide you through the process of product installation, configuration and 
usage, as well as provide basic troubleshooting procedures. 

Licensing 

Luxriot Face Recognition is available in two editions: Basic and Enterprise. Differences 
between versions are summarized in the table below. 

Features Luxriot FR Basic Edition Luxriot FR Enterprise Edition 

Max number of faces per 10s 5 500* 

Max number of simultaneous 
video streams 

2 10** 

Max number of simultaneous 
faces per second per system 

1 50* 

Min face presence time 1 second* 0.1 second 

*Server hardware must comply with recommendations 
**Up to 200FPS per system, server hardware must comply with recommendations 
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Prerequisites 

Supported OS 

Microsoft Windows 64-bit versions only, no 32-bit (x86) version support.  

Supported editions: Windows 7, Windows 8, Windows Server 2008, Windows Server 2012, 
Windows Server 2012 R2  

Important note: there is no support for virtual environment. 

System Hardware Requirements 

LFR requires that .NET 4.5 framework is installed on the server. 

The following recommended hardware specifications refer solely to the LFR; other modules 
like Luxriot VMS are NOT included into this estimation. 

Edition Luxriot FR Basic Luxriot FR Enterprise 

Connected 
video streams 

1 2 1-2 3-10 

CPU 
Intel i3 2.8GHz+ 

(4 threads) 
Intel i5 3.0GHz+ 

(4 threads) 
Intel i7 3.2GHz+ 

(8 threads) 

Intel i7 or Xeon* 
3.2GHz+           

(16 threads) 

RAM 8GB 16GB 

Storage ~1GB** per 1000 recognition results 

*Single CPU systems are recommended 
**Calculated for a FullHD stream. Exact size depends on actual video stream resolution.  

Recommendations 

Face recognition result precision greatly depends on the quality of input image quality; 
therefore, sufficient attention should be paid to camera installation and preliminary work 
with LFR configuration. Please consider the recommendations below and use them as a 
checklist when deploying an LFR system. 

Utmost attention is required at the subjects’ enrollment stage. The input image is converted 
into a set of facial features, forming a template that is saved into the database and used for 
identification and verification of people. Therefore, it is crucial to provide highest possible 
quality of the enrollment images: 

- Use clear, sharp images with distinct facial lines with no blurring effect and normal to 
high contrast range 

- Use near-frontal, full face view with minimum rotation (less than 15°) in any direction 
- Upload multiple images to cover slight differences of face views from different sides 
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- Neutral face expression during enrolment is strongly recommended: avoid frowned 
faces, closed eyes or eyes looking away from camera, raised eyebrows, broad smiles; 
however, slight changes in facial expression are recommended to “train” the engine 

- For people wearing glasses, make sure to enrol both images – with and without glasses 
- Same recommendations are applicable to people who are likely to have changes in 

appearance because of facial hair like beards and moustache, or due to seasonal 
variations – hats, makeup etc. 

- Glasses with thick, heavy frames and sunglasses decrease recognition accuracy 
- Person should occupy 50 to 100% of screen height 
- Minimum distance of 50 pixels between eyes is recommended, and 75 is advisable in 

order to obtain better recognition rate (note that this distance should be native and not 
obtained by stretching the image) 

- Minimum stream resolution is VGA (640x480 pixels), and you need to make sure that it 
is also native resolution, not a scaled-up low quality image 

- Avoid scenes where extraneous objects can distort the face, e.g. glass, rain , mirrors 

If light conditions of the scene can be controlled: 

- Direct frontal light or diffused lighting is recommended in order to have minimum 
shadowing within the face region, so that light is evenly distributed on each side of the 
face (both left to right and top to bottom) and face does not coalesce with background 

- Make sure that light amount does not depend on the hour and other environmental 
factors 

- Avoid additional illumination that can appear unpredictably, sunlight in the first place 
- Use such light sources that will not produce bright shiny reflections and glares on 

glasses and skin 

Camera choice: 

- Use cameras of similar quality (or the same camera) for both enrolment and 
identification images 

- If camera is set up to mirror the image, make sure that faces have the same orientation 
across all images because facial features’ template is different for the mirrored and 
non-mirrored pictures of the same person 

When deploying the system: 

- Train operators to check if the person is facing camera the right way 
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Getting Started 

Product Installation 

Run Luxriot FR installation package and wait until it is set up on your system. Immediately 
after setup has been complete, you will be able to run LFR directly from the setup wizard 
finish page. Alternatively, you can always run LFR as described below. 

Before launching installation, press Options in case you wish to change the installation 
directory. 

 

First Run 

Start Luxriot Face Recognition service shell by launching Face Recognition Service Tray Tool 
shortcut from your Desktop. LFR icon will then appear in your system tray, allowing you to 
start and stop the service simply by right-clicking the tray icon and choosing the 
corresponding option. 

 

Luxriot Face Recognition server itself has no graphics user interface, running silently as a 
Windows service, but has a Web based management console, easy to access and to use.  
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Having installed and launched LFR service, you can access its control centerby clicking Face 
Recognition Service Configuration icon or your Desktop, or manually via Web browser using 
the following default parameters: 

Address: localhost or local IP address 
Port: 8081 
Username: admin 
Password: admin 

You will be able to change these settings later via Service Settings. 

For the parameters above, console access link will look like http://localhost:8081. 

License Activation 

When you first open the Web management console, you will be asked for license key 
activation. Later, if system will already have a license installed, you will see your current 
license edition; in case of Basic License, you will also have an option to upgrade to 
Enterprise. 

When navigated away from the Web Management console main page, you will still see your 
license information and a link to license manager in the page bottom left corner. 
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Following options are available: 

Online activation: choose this option to activate your license on the current 
computer. This mode is suitable if the computer in use has Internet access and will 
be operating as face recognition server. 

Offline activation: if your face recognition server has no Internet access, follow the 
procedure described below in order to activate your license. 

Trial license: request a demo license key to unlock all features ofLuxriot Face 
Recognition for a limited time period. You can choose between Basic and Enterprise 
license editions. 

Note that Luxriot Face Recognition license is bound to the server hardware set, therefore 
hardware changes may cause license activation failure. 

Trial LFR license 

For Basic Edition license, simply hit Activate button. 30-day evaluation license will be 
automatically generated and applied to the current system, and you will be redirected to the 
Luxriot Face Recognition start page. 

License edition limitations are described in the corresponding chapter of this document. 

If you wish to obtain Enterprise Edition license for extended testing, select Enterprise License 
Trial Edition option, copy your Trial Request ID and contact Luxriot representative, who will 
provide you with Trial Key. Once you have received it, enter your Enterprise Trial key into 
Trial Access Activation form and click Activate. 

Important note: trial licenses require Internet connection in order to operate. 
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Offline Activation 

If your LFR server is located in an isolated environment with no Internet connection, you can 
use another computer with Internet access to activate your LFR server license. 

 

First, enter the FR license key that you have purchased from Luxriot or authorized reseller, 
and then hit Download ID File button. System will not generate any files for empty or 
incorrect license keys. 

Next, copy the ID file to a computer with Internet access and send it to Luxriot 
representative or technical support center support@luxriot.com. Luxriot will process your 
license activation and will provide you with another file to confirm license registration 
process. 

Having received the activation file, click Browse and upload it, then hit Activate button to 
complete the activation process. 

  

mailto:support@luxriot.com
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Service Management 

Service homepage offers quick access links to system settings and subjects’ database 
management. Subjects are also accessible from within Service Settings; once you are done 
with server/camera setup, you do not have to browse the settings but rather use the quick 
access link to open the subjects’ gallery. 

 

Service homepage summary also shows information about current registered license and 
offers an opportunity to upgrade the license.   
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Service Settings 

You can change connection settings and administrator user account details here. Initial 
parameter values are listed below, with default password being admin. Note that these 
values will also be used if server configuration is corrupt or has been deleted. 

 

Single user profile is available, but you can pick any username and password you like 
considering that it is allowed to use uppercase and lowercase Latin characters A-Z and a-z, 
and digits 0-9. No special characters are permitted. 
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By default, LFR uses its own database file. Do not change the ODBC connection string unless 
you wish to use your own database and you know exactly what you are doing. 

Pre-defined directory for the frame archive is C:\ProgramData\Luxriot\Luxriot Face 
Recognition\Frame Archive, and default storage limitation is 50% of the total disk size. This 
means, a maximum total of 50% of disk is allowed to be full. If your disk is already 60% full 
even without FR archive, and you set quota to 50%, no frames will be saved. 

Storage quota mechanism does not know about any other quotas applied to the same disk: 
e.g., if Luxriot VMS is set to use the same storage location and it fills up the storage so that 
LFR quota is exceeded, no frames will be recorded as well. For instance, if your disk is 
currently 20% full and you set quota to 50%, LFR will use a maximum of 30% of disk space. 

Server Setup 

To start actually using the recognition engine, it is necessary to connect to Luxriot VMS 
server that contains FR cameras pre-configured, and then add desired cameras to LFR. If you 
have not set up your Luxriot VMS Server yet, proceed with VMS setup and get back when 
you are ready. 

First, you need to choose a VMS Server to connect to. 
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Server: VMS Server computer IP address or hostname. 

Port: VMS Server port for Client connections (default is 60554). When connecting to a 
remove VMS Server, make sure this port is allowed on all intermediate routers and firewalls. 

User and password: VMS Server user account to connect with. Depending on the connection 
type, user must have corresponding privileges (connect locally or remotely) and must be 
allowed to receive video from FR camera. For full description on VMS security setup, please 
refer to Luxriot VMS user manual. 

VMS Notification – Title: the name that will appear in VMS as external event source. 

VMS Notification – ID: unique LFR server identifier. ID is assigned automatically, so you do 
not need to enter anything in this field. The only case when you need to use custom ID is 
when you want multiple LFR servers to look like single FR source in VMS Client: in such case, 
you need to copy one server’s ID to ‘add-on’ servers’ Identifier field. 

Once you have entered all settings, click Add Server. Connection with VMS will be 
established automatically: if VMS Server is online and reachable, you will see server status 
saying connected. If VMS Server is offline, LFR will endeavor to connect every few seconds 
until it reaches the server. Open Diagnostics section to see the details on unsuccessful 
connection attempts. 

You can add one or more VMS servers to a single Face Recognition server. 

To edit or delete existing server, simply move your mouse over the server name and 
corresponding controls will appear on the right side.  
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Camera Setup 

Server setup only establishes connection between LFR and VMS on the service level. In order 
to start recognizing people, you now need to choose video streams and define recognition 
parameters for each one. It is strongly advisable that you read and follow recommendations 
regarding camera positioning, which are available within this document. 

To start new camera setup, click Add Camera button below the camera list. To edit any of 
the existing cameras’ settings, as well as disable/enable face recognition for specific device, 
simply click Edit for the desired camera – this is similar to editing server settings. 

Select VMS Server from the list of your connected servers and then select one of the 
cameras. Note that camera must be enabled in VMS and server must be connected in LFR. 
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Face Detection Engine Settings 

Settings below affect the process of face recognition, that is, the identification of human 
faces based on the set of specific features. For all settings, recommended values are 
provided based on two conceptually different typical scenarios: 

#1 “Quick harvesting”: on-fly detection in crowded regions and large flows of people, 
certain amount of false recognition acceptable. 

#2 “Double check”: authorization or identity verification of a single person, high demands 
for accuracy. 

 

By default, recognition is enabled for the camera being added, so that face detection engine 
can start working at once right after the camera is added. However, you can uncheck this 
option if you wish to start recognition manually later. 

Image Quality Requirements: is used when searching for faces in the image. Images with 
lower quality will not be considered. Scenario #1 allows lower quality level, while #2 requires 
bigger value of this parameter. 

Matching Similarity: this parameter should be set according to the desired false acceptance 
rate. The higher probability of false rejection is required, the higher threshold should be set: 
increased similarity level in recommended for scenario #2. 

Face Deviation Angle: max angle deviation from frontal view, in degrees; max value is 45° in 
one direction. This parameter implies both horizontal and vertical angles. 

Minimum Ocular Distance: defines minimal distance between eyes in pixels, must be in 
range [60..10000]. Faces with smaller distance between eyes will be ignored. Minimum 
recommended value is 90 pixels. 
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Face Matching Settings 

Turn ON detection of unknown persons if you want to save every single recognized face. 
With this setting OFF, only persons matching one of your subjects will be available, and 
other recognition results will be ignored. If you know that no unknown persons should be 
there – e.g., when LFR is used as an additional security check in the scenario #2 – it may be 
advisable to disable this option in order to eliminate cases when a subject present in the 
database is detected as unknown because of unusual facial expression or rapid head 
movement. 

You can choose to save recognitions of every face, including those yet unknown – in case 
these are detected – and use these images to enhance your subjects database later on; or, 
stick to saving pictures of known persons only. In the latter case, you will still have events of 
unknown persons’ detection but there will be no pictures saved in the LFR frame archive. 

Unknown Person Recognition Delay: time in milliseconds for the engine to try to find a match 
for the recognition result in the known persons’ database. Delay should be consistent with 
the time period during which a person stays in the recognition area and adjusted for each 
individual scene. For scenario #1 above, lower value is better as it allows more faces to be 
handled, especially in case of high speed people flows. For #2, longer delay may be 
considered for improved face matching accuracy. Also, note that recognition event will be 
only triggered after the delay. 

Face Absence Timeout: minimum time period in seconds to wait until a face triggers a 
recognition event again. Set higher parameter value if you do not want a face to be reported 
as recognized repeatedly when it is likely that the person will stay in the area for some time. 

When finished with camera setup, click Add Camera to save and return to the camera list. 
You can get back to these settings any time you want simply by clicking Edit button. 
Correspondingly, the bin icon will delete camera from the list with all existing settings: an 
attempt to add the same camera again will not restore its previous parameter set. 
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Camera Test 

Aside from showing real-time recognition status for every camera (Disabled/Enabled), 
camera list offers one more useful feature: test recognition with current camera parameters. 
This should be used to check actual recognition if you do not receive any events in VMS 
Client. 

Using Test you will see if: 

- Recognition actually works for your camera and settings  
- Recognized persons are added to the database  

Those subjects’ recognitions that have in database status will be sent to VMS as recognition 
events. 
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Subjects Management 

You can create your own database which will be used for comparison and identification of 
detected persons.  

Once you have entered the initial set of subjects and LFR has been deployed and operating 
for some time, it is possible to get back to the subjects management to update their face 
galleries. In such a way, recognition engine is trained to identify the person more precisely 
and easily, and also keep up with the changes in persons’ appearance.  

 

Important note: Please consider Recommendations section of this document to develop 
best techniques of adding subject pictures. Requirements for the picture quality here are 
very strict: this is necessary in order to obtain high recognition rate during system operation. 

Each entry has the following attributes:  

Subject Name: usually, person’s title/name/surname or other ID used to distinguish him/her 
from others, and also to enable subject database search. 
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Face Gallery: set of photographs a bit different from each other so that recognition engine 
can detect the person from various angles and with slightly different appearance/facial 
expression. Browse for and add multiple pictures, then hit Apply: application will 
automatically crop the picture so that it only contains the face. 

Tag: subject’s attribute based on the access level, can further be used for white/black lists. 
Select one of previously created tags from the drop-down list or click Manage Tags to 
add/change existing ones. Select one of the suggested colors for the tag or pick your own 
one, and click Add to create a new tag. Create classification to suit your project specialty. 
Selected color will be used to highlight the recognition result in Luxriot VMS Client panel 
with recognition events. 
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Diagnostics 

Diagnostics page provides you with important server events like: information on LRF service 
start, license check, server and camera connection. In the example here, LFR service has 
successfully started, connected to its database and validated the license, but VMS server on 
localhost is not running so connection could not be made. 

You are kindly requested to provide information from this page when applying for technical 
support. 
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Events in VMS 

Luxriot VMS Client can receive recognition events from LFR as incoming messages containing 
information about recognized persons.  

Real Time  

In order to receive live events from LFR, go to VMS Client main menu View -> Panes -
>External Events (or simply press Alt+Shift+X) and then select desired LFR server from the 
drop-down list to bring the External Events pane. Multiple panes can be brought to the 
screen. 

Live events can be filtered by camera name or displayed all at once.  

Double click an event to bring corresponding camera to the screen. Same can be done by 
right-clicking event -> Map onto first available screen. Camera will be mapped to the first 
empty screen in the camera layout, or, if there are no empty screens, replace the first non-
pinned camera. 

Archive Investigation 

Note that it is necessary to set up video recording for your camera in order to be able to 
view it in the Archive. 

Right-click recognition event in Live View mode and choose Open Archive to bring up the 
multichannel archive window. Archive view will automatically switch to single camera view 
and jump to the exact moment of time when the clicked event has happened. 

Similarly to the Live View mode, External Events pane can be placed on screen to enable fast 
browsing among all reported events. Here, double-clicking an event will instantly display the 
corresponding moment of video stream, jumping along the timeline. You can add one or 
multiple LFR external event sources. 
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Search tab allows browsing recorded events using Subjects’ name criteria. Options:  
- Select up to three names to be matched as search criteria 
- Define desired time period  
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Event/Action Configurator 

Luxriot Face Recognition events for every device can be also used as triggers for particular 
actions inside Luxriot VMS, such as: start or stop recording, send e-mail, pop up 
camera, go to a PTZ preset, run third-party application and others. 

To set up event and action map, open the configurator in VMS – either via Wizards -> 
Configure server’s events, or by right-clicking your server -> Tasks -> Configure server’s 
events. 

In order to add events for specific camera, right-click camera in the Events column and select 
Add Event, or go to Tools -> Configure devices and do the same. In the Type drop-down list, 
select your Luxriot FR instance that is handling this camera and then, in the Event drop-
down list, choose a tag to be treated as an event. Click OK to save your new event. 
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After you have created one or multiple recognition events, they will appear under 
corresponding camera and will be available for mapping. Use >> and << buttons to create a 
map of what will happen when recognition events occur. Do not forget to click Save button 
after you have finished. 

Note that here, once created with LFR Event type source, Event/Action Configurator objects 
are not automatically updated when FR settings are changed. This means, if 
subject/tag settings are modified, corresponding old events in the Event/Action 
Configurator should be deleted and new events should be created instead, in order to 
maintain event/action map operability. 

For more details on event setup in VMS, please see Luxriot VMS User Guide, under “Event 
and Action Management Wizard” section. 
 

  

http://www.luxriot.com/files/Manual_ENG_.pdf
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Troubleshooting 

Q: During installation, setup shows errors or takes forever to finish. 

A: Abort installation and reboot your server computer, then try again. If the issue persists, 
contact Luxriot support, providing exact error messages and/or snapshots. 

 

Q: I have activated my license key but no faces are detected from cameras.  

A: Check bottom left corner of the Web console for activation errors: click Retry to attempt 
to fix the error; then, check Diagnostics page for details. If the error cannot be corrected 
automatically, contact Luxriot support.  

 

Q: I have trouble uploading pictures in Subjects Management, LFR says No faces detected. 

A: Please refer to Recommendations section of this document and go through all steps 
carefully, making sure that pictures’ quality is suitable. Engine requirements for sharp facial 
lines and no inclination are strict. Use Paint or any other graphics editor to make sure that 
distance between eyes (in pixels) satisfies required minimum (60px minimum, 90px 
recommended minimum). 

 

Q: I set archive quota to <percentage> but no frames are saved. 

A: Check your disk space. Defined quota refers to total disk space, not just LFR: for example, 
if your disk is already 60% full even without FR archive, and you set quota to 50%, no frames 
will be saved. 

 

Q: Server status shows Disconnected in the servers list. 

A: Make sure your VMS Server is running and reachable and has incoming remote 
connections enabled. If you are able to connect via telnet <VMS IP/hostname><VMS port>, 
LFR will successfully connect as well. Then double check server settings in the LFR. 

If you have been unable to determine the reason of disconnect, open Diagnostics section to 
see details on connection attempts, and provide these to the support team when reporting 
the problem. 

 

mailto:support@luxriot.com?subject=Luxriot%20Face%20Recognition%20issue

